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Use this
space for notes

Introduction

This CalAgenda course has been created for CAL PACT participants to learn more
about the features of the CorporateTime scheduling software. The course covers
introductory-level material that applies to both the Windows and Macintosh
computer platforms. This document serves as a future reference for you as you
continue to gain experience on your own. Some topics may not be covered in as
much detail during class as they are in this document. Documentation for previous
versions of CalAgenda/CorporateTime, as well as for other courses, is available on
the CAL PACT website: http://calpact.berkeley.edu.

Skills you need for this class
* How to use the mouse
* Familiarity with the Windows or Mac operating systems

Skills and concepts you will learn in this class
* Accessing your account
* Changing user information and passwords
» Searching for users, resources, or groups
* Working and scheduling events, notes, and tasks
* Creating and managing groups
» Setting access rights and user preferences
* Accessing your schedule via the web

Conventions used in this document

Menus and menu commands are separated by a vertical bar (| ). In the document
they will appear as Menu|Command. An example of this is: “Select File|New....”

Icons in the left margin

Occasionally, you will notice icons in the left margin. Their purpose is to highlight
important information. Examples:

> v
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Tip

To quickly log into your
account, choose the
“Enable Automatic Sign-
in”  option in the
Connection Manager
diaglog box.

.9
Caution »<

To avoid losing your
display settings, be sure
to go to the menu bar and
logout from the file menu.

Note \:b'

What is this program
called? CalAgenda? Or
Corporate Time? The
software used is called
CorporateTime, but the
service on campus is
called CalAgenda, so you
may hear these two terms
interchangeably.

Starting Up and Signing On

Upon opening CorporateTime, the dialog box
shown at the right will appear. In the upper
field, choose which server you wish to connect
with or choose the Off-line option if a network
connection is not available. If no server is
listed, click the Other button.

CorporateTime®5.0
Lonnectio e |
[ | i |t |

© Copyright 1993-2000 Corpardle Softwate & Technologies Inl Inc. All ights reterved.

You will see the dialog box at the right appear
on your screen. To create a new server, click
on the New button and fill in the appropriate
information. If you wish to make calagenda
your default server, highlight calagenda and
click on the Make Default button.

Connection Manager

0 f-line

avantgenda

In the CorporateTime window, a graphical
indicator in the status bar is also available to
show current program status.

=2y This indicates that the program is
running off-line.

=-=qp This indicates that the program is running on-line.

This indicates that there are new entries in the In-tray.

&t

Signing on as a resource

When signing on as a resource, you have the ability to change the access rights
and password.

Changing User Information and Passwords

To view the user information that is available for others to see, select Option|User
Information. To change the password, select Options|Change Password. The
User Information is secured so that changes cannot be made, but if you need
changes made to this information, contact your CalAgenda administrator. \WWhen
changing the password, it must be changed twice, once for the server and once for
the Off-line option. Log in to the server and change the password. Exit the program,
log in once more using the off-line option and change the password again. If this is
not done, CorporateTime will ask for both passwords.

Accessing Help

CorporateTime contains context sensitive help which can be accessed at anytime
by pressing the F1 key on the keyboard or by clicking the question mark (ﬂ) if it is

available. The help screen will display information pertaining to the selected area on
screen or the active dialog box. The general help screen can be accessed through
the Help menu. The help screens operate exactly as they do in other programs.
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Searching

Searching for users, resources, and groups is one of the most important tools in
CorporateTime. After all, it's impossible to schedule an appointment unless you can
find who to schedule with. The search screen can be accessed with the search

button (@) in specified dialog boxes or by selecting Directory|Search

Directory... at any time. Accessing the Directory Search is useful for finding
information on a person or resource, but it does not allow for adding the results to a
list. When the search is accessed with the search button, the search results can
be added to a list.

Single User Searches

Single user searches are accessed e =
when only one person, resource, or [Fesouces| Grope]
group can be used. The dialog box [ B

contains th.ree window tabs with thg ‘ el
search topics. Enter the search criteria

in the field and click the Search button I B R
to perform the search. The full kg [

information for each field is not
necessary. Entering partial information
will return all results that match the
criteria. The search results are
displayed in the lower portion of the
window. The window will only display
100 results, with a scroll bar. To narrow
the search, enter more criteria and click the search button again. Print the results
by clicking on the Print button on the lower portion of the window. To view the
specific information on a result, highlight the result and click the Information button.
Once the desired resource is found, highlight the result and click OK to add it.

Searching for resources operates with the same functionality. In the Resources tab,
there is one special checkbox option labeled “Local Resources only.” With this
option checked, the search will be limited to resources contained on the local
server only.

Multiple User Searches

Multiple user searches are accessed through the search button when multiple
people or resources can be used. The functionality of the search tabs operate the
same, but there is a difference in the results list. The search results are displayed
on the bottom left of the screen. To add search results, begin by selecting the
desired result(s). The keyboard modifier Shift can be used to highlight multiple
consecutive results and the keyboard modifier Control can be used to highlight
multiple nonconsecutive results. Once the desired results have been selected, click
the Add button to move the results to the right hand portion. Use the Add all button
to add the entire list of search results. To remove names that have been added,
select the name(s) and click the Remove button.
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v

Tip

To save time in future
searches for items, select
each option in the first two
columns.

v

Tip

For Macintosh users:

When adding individual
people to searches or
meeting proposals, don’t
hit return after you type
their name. This will
simulate clicking ‘OK’ and
will finish your task.

Instead, hit Command +
Return or click the green
checkmark button.

Directory Searches

The directory search is accessed whenever the Directory|Search Directory...
command is selected. The functionality of the directory search operates the same
as the single user search, but you are not allowed to add the search results to any
list. This feature is used mainly to locate information on people, resources, or
groups.

Locating a Person...

In the Directory menu, a special
command Locate a Person... is [GRP-CAL PACT ¥ 2]
available to search for the activity of a o[ 14 155 D] o [0 m EHO]
person, resource, or group at a specific [T _

time and date. In the window that OBusy

appears, enter the search parameters »>Ho avalable information

and click on the green check. Notice that

a tab for resources or groups is not

available. To search for a resource,

precede the search string with r:, re:, or L Help

res:. To search for a group, precede the
search string with g:, gr:, or grp:.

Where ls_.. E3

Searching Your Agenda

To find specific items located in your
agenda, select Edit|Search
Agenda. Under the Search Options
tab, you can set where the program
will search for your item. In the
search field, type the item you wish
to find, then click the search button.
Next, select the period of time you
wish to search. Note that the period — —
will automatically default to your o aaen s
current view settings (day, week, or

month). If you wish to search for a

specific person who will be attending an event, type their name under “Search
Attendees List.” When you are done, click the search button.

[03-19- 2 (Y

6525 1 SN

Choosing Dates

In many of the available windows, a date control bar will appear to specify or
change dates. The single arrows will move the current date backwards or forward
by one single increment. The increment depends on the current view in
CorporateTime. For example, when viewing a single day, it will move one day; when
viewing a month, it will move one month. The double headed arrows are used to
move by larger increments. Once again, this depends on the view. When viewing
one day, it will move one week; when viewing a month, it will move six months.
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Movember = |[1998 =
i | (N To choose specific dates, click the calendar button

@MEE and a small window will open. The pull down menus

Mo Tu Ve Th Fr Sa su | gyailable at the top will control the month and year. The

26

)

28| 29)30]31] 1

2

3

arrows have the same functionality -- the single arrows
415678 will move the month; the double arrows will move the

i

10

11 (12]13] 14 year. Once the month and year have been selected,

16

17

18[19]20] 21|22 select a day from the small calendar view below.

23

24

2z 25|27 | 25| 29 CorporateTime will not recognize any changes unless a

30

1

AERNERE day has been selected in the calender area. To make

things easy, clicking on the Today button will

automatically select the current date.

Working with the Agenda
Opening an Agenda

To open an agenda, go to the File menu and select the Agenda option. Then select
one of the following three options:

Open - This option will allow for opening an individual agenda. In the dialog
box that appears, select the option to modify your own agenda or enter the
name of the agenda to view. Notice that the search button is available to
search for an individual or resource. If a resource agenda is desired,
precede the name with one of the following - r:, re:, or res:. The last option
available to modify the agenda as a designate is a special option which
allows you to make changes to another person’s agenda. The owner of the
agenda must give you proper permission in order for you to be a designate.
This will most likely be a function used by those on campus who have
designates that maintain their schedule or coordinate calendars for
managers.

Open As Designate - This option is used to open group or resource
agendas as a designate. As previously discussed, the proper permissions
must be granted in order for the designate to make changes.

Open Group View - This option is used to create or modify a group
containing multiple people or resources. This allows a combined view of the
agendas at the same time, thus making scheduling easier.

Changing the View

There are three possible ways to view a CorporateTime agenda. These are broken
down into day view, week view, and month view. To switch between the views, use

the toolbar buttons (g | = |=i).
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v

Tip

Note that it is possible to
have multiple agenda
items at the same time.
This will be displayed in
multiple columns on the
same day.

The Day View

A sample of the day view is
shown at right. The window
is divided into three separate
panes - the agenda, current
tasks, and notes. Icons and
colors within each pane are
used to signify individual
elements for each entry.

Each pane can be resized
by clicking and dragging the
border line between panes.
The mouse cursor will
change to double headed

arrows (+7»).

The interval and size of the
time blocks of the agenda

s Kuo Yu-Tin -11-16-98 - PST8PDT

File Edit Directory Options  Miew ‘Window Help

0N EE25 DR 8¢

/V A0 Today s s [zl Monday, Nov 16, 1998 (Week 47)

ﬂ O Cracle Server Licenze
O saL Server License

10:00am
10:30am
11:00zm
11:30am
12:00pm

12:30pm

1:00pm

1:30pm

2:00pm

w volleyball

For Help, press F1 | Sunday, Nov 15, 1998

can be resized to suit the preferences of any user. Make the height of each time
block smaller or larger by selecting View|Decrease Row Height or Increase Row
Height. This does not change the interval of each time block, just the size. To
change the time interval, select View|Decrease Time Slot or Increase Time Slot.

Each time block can be changed to represent a time interval between five minutes

and one hour.

The Week View

The week view will display between five to seven days in the agenda depending on
the set user preferences. The lower pane displays any notes attached to each day.
Using this view, the tasks are not viewable in the window.

The same controls exist to change the interval and size of the time blocks.

& Kuo Yu-Tin - Nov 16 to Nov 20, 1998 - PST8PDT

File Edit Diectoy Options Yiew Window Help

< O E & &

#E=E bR GO

Vs

A Today s Lk

G Monday, Mow 16 to Friday, Mow 20, 1892 (Weel 47

Monday 16

11:00am

11:30am

12:00pm

12:30pm

1:00pm
1:30pm
2:00pm

2:30pm

Tuesday 17 Wednesday 18 Thursday 19 I Friday 20

T B-Gate Fe 2ased]

For Help, press F1

[ Sunday, Nov 15, 1938 [432pm 7|
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The Month View

The month view will display an entire month with the associated agenda events and
daily notes. Each day will display as many events or notes as possible. If more
events or notes exist, the downward pointing hand will appear. The additional items
can be viewed by selecting a visible item and using the down arrow on the
keyboard. Like other views in Corporate Time, the grid can be readjusted by clicking
and dragging when the mouse is on of the grid borders. To reset the grid, use the

10:00 am Data Fundarm
10:00 am Excel 3 EMTE

10:00 am BCE UMTF
1:00 pm CAL PACT Ac

& Oracle Conferent

12:00 pm CAL PACT W
e Oracle Conteren

toolbar button ().
#* Kuo Yu-Tin - Nov 1938 - PST8PDT [_ O] %]
File Edit Directoy Options View ‘Window Help
SO0 E 58 k@ 95
A Today  » ss = B Now 1598
Mon Tue Wed Thu Fri

26 27 28 29 30
44
e 3 4 5 &
45 9:00 am AS0 Warkshc [11:00 am Meet wiOw

1:00 pm CTime Test Tr

B w [10 7 11 12 13

9:00 am Meet Glenn
10:00 am Student For

16
1:00 pm Excel 4 UMTF
300 pm Access

17

i [1a

10:00 am CTime EMTF | 10:00 am CTime EMTF
10:00 sm Win S5MT UL 1:00 pm CTime EMTF

19
1:00 pm CTime EMTF
3:00 pm CTime EMTF

20 #
11:00 am Student Fory
1:00 pm CTime EMTF

23
10:00 am CTime EMTF
2:00 pm Meeting Lollsd

24

25
T Margie Lin's B-Ds

26 Thankagiving Ho
‘ﬂ, Thanksgiving Holi

27 Thankagiving He
‘ﬁ. Thanksgiving Hol

eli}
9:00 am Brio 2

EHeIp, press F1

2

3

n

| Sunday, Moy 15, 1998

434 ¢ /ﬁl

m
12:00 pm Ddinch

Quick Trick: Click on the date row and the day view for that day
will automatically appear. To switch back to month view, use the
toolbar button.
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Scheduling Agenda Entries

CorporateTime offers a variety of methods to add agenda entries.
+ Select Edit|New|Meeting.

* Click the New Meeting button in the toolbar (@).

* Double click the time slot in the Day view or Week view.

» Select the block of time in the Day view or Week view, type the entry title,
and hit enter. Double click on the entry after to edit settings.

Double click an empty region for a date in the Month view.

Using any of the above methods, the entry dialog box will open on screen. This
dialog box consists of six or seven window tabs on a PC or icon categories on a
Mac depending on the method used to create the event.

Mew Meeting [ x|

General | Dptiahz | Repeating | Details | Linked Tasks | Reminders |

Propozed by Kua, Y u-Tin

Title: IEnrpnrateTime training

Location: |2E2 Evans Hal

Date: Start time: Duratian: End time:
[11-19-1998 E@,| [10: 00 am E®| IDEh:DDE [12: 00 pmm E®|
— People and rezources
bdd | | @l
@ Fuo, Yu-Tin Delete |

Check conflicts Suggest datedtime

Create I Cancel Help

The General Tab

In the general tab, enter the desired setting for each of the available fields. Some of
the fields may already contain information depending on the method used to add the
new entry.

Proposed by - This entry cannot be modified. It specifies you as the entry creator.

Title - This field defines the title for the entry
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Location - This field defines the location for the entry.

Date - This field sets the date for the entry. Change the date by
1. selecting a portion of the field and typing in the entry,
2. using the up and down arrows, or

3. using the date button () to choose a date.

Start Time, Duration, End Time
These fields define the period for the

agenda entry. Afun feature available |.|.|.| ™ #.l.l.l.l.l.l.l.l

for these fields is the time control 10am 11 12 1 2Zpm 3
button (@). Click this button and a
time control will appear on screen. ok || Concel | e |

Click and drag the blue arrow to
automatically adjust the time for the field.

People and Resources - Invite people, resources, or groups to the agenda item.
In the Add field, type in search criteria and click on the green check. The group

listing and directory search buttons ( @l) can also be used as an alternate
method.

Check Conflicts - This button will check the current entry setting against your own
schedule to look for conflicts. If a conflict is found, the conflicting entry will be
displayed in a separate window.

Details of Conflict ]|

Conflict date: Thu, Mow 19, 1938 at 12:00 pm

1  peoplefresources in conflict 2 keeting: cauzsing conflict

Fuo, Yu-Tin CTime EMTF
CTime EMTF

Help |

Suggest a date/time - When a conflict is found, the last button in this tab will open
a new dialog box on screen. In this window, set the desired preferences and click
on the List suggestions button. CorporateTime will scan all agendas and suggest
dates and times that match the criteria. If a suitable date and time is found, select
the listing and click OK.
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The Options Tab

Importance Level - This field sets the importance level for the entry. A special
indication only appears in the agenda view if the color scheme is set to the
importance level.

Access Level - This field sets the access levels for others who view the agenda
entry.

Tentative Check Box - This check box will mark the entry as a tentative item. In
the agenda view, the entry will appear in a separate color.

The Repeating Tab eo &

This tab is used to automatically

schedule the event in the future & T oo mary dates will be created.
(i.e. standing meetings). Adjust the

desired setting and click the List
Dates button. CorporateTime will
list all of the dates. The maximum
number of dates is approximately
55. If the time span is larger,
CorporateTime will display a dialog box. The dialog box will always appear without
listing any dates on a Mac, but will only appear on a PC if the Holiday checkbox is
used. This may be a bug in the program.

The Details Tab

The Details tab is a useful area to include comments or a better description about
the event. The description will be seen by all people who were invited to the event.
In the lower portion of the window, an Attach button is available to attach
documents (like a meeting agenda) with the event. This is similar to an attachment
for e-mail. Only one attachment can be added per event, even if it is a repeating
event. If a file has been attached, double click on the icon and the file will be
opened. To remove the attachment, click the “Remove” button.

The Linked Tasks Tab

The Linked Tasks tabs allows you to schedule tasks which are linked to the current
event. Click on the New button and the New Task dialog box will appear. This dialog
box will be described in detail later. Any new tasks created in this area will appear in
the normal task views available in CorporateTime. To delete a task, click on the
Delete button. To keep the task, but unlink it to the event, click on the Unlink
button.

The Reminder Tab

The Reminder tab is used to provide on-screen reminders for agenda events.
Check the radio button to activate the reminder and choose the desired settings.
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Note \:&'

You may choose to email
all the event participants;
however, a CalAgenda
user may set her
preferences to never
receive email from Cal
Agenda. If so, she will not
receive the email you
choose to send.

The Reply Tab

The Reply window is
most commonly used
when you are invited to
an event. This window
tab allows for
confirmation of
attendance to an event. Check off the desired options and close the window. The
event status will be automatically updated in the agenda of the event creator. Notice
that a checkbox is available if another time is preferred. This checkbox works
independently of the other options. A button also exists for e-mailing the event
participants. Click the button and a window will open on screen. Add any message
desired and click OK to send the message.

kLo, ru-Tin

[T | would prefer another time

| will ot attend

| will corfiemn later

Finalizing the Event

After adjusting all of the event settings, finalize the event by clicking on the Create
button or OK. If other people were invited to the event, a dialog box will appear
asking to mail the other invited participants. Choosing to mail the participants will
send an actual e-mail to the other participants with the event details. This is a useful
feature for participants who do not have the CorporateTime software in their office
because they can receive information on the event. If an invited participant uses
CorporateTime, an e-mail may not be necessary because they will automatically
receive notification of the new event within the CorporateTime program.

Scheduling Day Events and Daily Notes

Day events are scheduled events which occupy the entire day or a large portion of
the day. This event will not block out the time slots in the Agenda portion, instead it
will appear in the notes section of the day view and the week view. Daily notes
operate similarly to day events. Functionality wise, there is no difference between a
day event and a daily note, they just appear with a different icon. The day event
appears with a blue flag icon () and the daily note appears with a red pushpin
(). Logistically, a day event should refer to an event which will occupy most of
the day; a daily note should refer to an event which must be accomplished
sometime during the day, but it does not occupy the whole day.

To schedule a day event or daily note, use the toolbar buttons: @ for a day event

and ﬂ for a daily note. An alternate method to create a daily note is to double click
in the notes section of the day view and week view. In the dialog box that appears,
set the desired setting for each window tab. The window tabs that appear are the
same tabs which appear for scheduling a new event, but without the hours fields.
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Tip \/

It is a good idea to use
daily notes or events to
inform your colleagues
about being on vacation or
away from the office. This
will avoid having your
events appear on their
agenda.

Scheduling New Tasks
Scheduling tasks can be done in a number of ways.
+ Select Edit|New|Task.

»  Click the New Task button in the toolbar ().

* Double click inside the task pane of the day view or the task view.

* Type a task name in the New window inside the task view and click the
green check mark.

Mew Task E

When the new task command Deseriptian:

is created a dialog box will [Froiec

appear Containing three Created on: Saturday, Sep 12, 1998
WindOW tabs: GeneraL General | Reminders Detailz
Reminders, and Details. In

the General tab, enter the task

name and adjust the settin aPIeET Pl = Lorpetec:

for the task. Ijlotice that ] [03-21-19% ] [os:00 am ED] 020z [§
checkboxes exist for the due I Statt date: Start time: W ek
date, start date, and | — =HE [ 0] - =5
completion date. These fields By peones el

can be used, but it is not WE I_F'elsonal—_[

necessary. The Reminders
and Details tab operate
similar to the tabs described
earlier for events. Once ok | Cencel Help
everything has been set, click
on OK and the new tasks will
be created.

Viewing and Editing Agenda Events

In any of the agenda views, the events will be displayed. In the day view and the
week view, each event will be color coded, and display icons showing the status of
the event. In the month view, only the event will be shown. To view the details on an
event, double click the event and the event dialog box will appear. If you are the
creator of the event, you will have the option of changing the event details. If the
event was created by another person and you were invited, only the event details
will be shown and you will not be allowed to edit the fields.

Alternate Methods of Editing Events

When using the day view or the week view, the title and time setting for an event
can be changed without opening the event dialog box. Click on an existing event to
select the time block and notice that the appearance of the event changes. A thick,
dark line will appear at the top and bottom. Directly edit the title by clicking once
more and typing. To increase or decrease the time span of the event, place the
mouse on one of the event borders. The mouse pointer will change to double

headed arrows (ﬁlﬁ). Click and drag to increase or decrease the time span of the
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event. To move the entire event to a new time, place the mouse inside the time
block. The mouse pointer will change to four headed arrows (++). Click and drag to
move the event block to another time. In the week view, the event can also be
moved between the days of the week shown on screen.

When working with the month view, events can be moved to different days, but the
time settings cannot be changed. Click and drag the desired event to different days
to move it.

Duplicating or Rescheduling Events

To duplicate or reschedule an event, highlight the event and select

Edit|Duplicate Meeting or Edit|Reschedule Meeting. In the dialog box, make
the necessary changes and click OK. CorporateTime will provide a warning if there
is a conflict with the selected day/time.

Deleting Events

To delete an event, highlight the event and (1) press Delete or (2) select
Edit|Delete Meeting.

Viewing and Editing Tasks

To view all of the scheduled tasks, select File|Tasks|Open or use the toolbar
button ([]). Similar to opening an agenda, you may choose to open your own
tasks or the tasks of another person. The task window that appears will display a
listing of all the scheduled tasks along with the respective details. To make the
listing easier to view, click once on a column header and the list will be sorted by
that column.

“¥ Tasks for Kuo Yu-Tin - PSTS8PDT

File Edit Directory  Options Yiew Window  Help

& O Ha © et 8o

Mew: IScheduIe CorporateTime Classed yi”l
Description TI Prio... I Star ... I Due... I % C. I
Oracle Server License 1 (Mone) 100%
[O=cL Server Licenze 1 [Mone) 0%

Faor Help, press F1 | Sunday, Moy 15, 1998 G
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The In-Tray

The In-Tray is the primary source for managing entries received or sent out to other
users. Open the In-Tray by selecting File]Open In-Tray, using the keyboard

shortcut Control+| (PC) or Command+| (Mac), or by using the toolbar button (7).

The In-Tray window will appear with four folders for each user: New entries, Entries
you've accepted, Entries you've sent out, and Entries you've refused. Click on a
folder to open or close the folder.

When you have been invited to an event, the CalAgenda server will automatically
notify you of this event in the New entries folder. By default, CorporateTime will
check for new entries every fifteen minutes. To force any folder to refresh the
entries, open and close the folder. Double click on any of the entries to view the
details of the event or to open the fast reply screen. The desired action for the
double click action can be set though the preferences (which will be discussed
later). An alternate method to reply to events is to click and drag them from one
folder to another. For example, to accept an invitation to a new event, click and drag
the entry from the New Entries folder to the Entries you've accepted folder.
CorporateTime will automatically adjust all of the necessary settings.

One quick way to view the participation status for an event is to click on the icon for
the event (1&). The event listing will expand to show the participants and the
associated status. A green check means the participant will attend; a red X means
the participant will not attend; a blue question mark means that the participant has
not replied. If any icon is accompanied by a gray circle with a red slash through it
(&), this means that the participant would prefer another time to meet.

& In-Tray M=] E3

E Yu-Tin Kuo =
&5 Hew entries
O CAL PACT Meeting Zhiozhita John Thu, Sep 24,1993 st 12200 pm - 12

+ Shinzhita John
3 Kuo Yu-Tin
P Kim Laura
&5 Entries you've accepted

{0 CAP Meeting w! Randy Saff Shioshita John Mon, Sep 21, 1993 &t 12:00 pm - 1.0
- Shioshita John
- Kuo Yu-Tin

&5 Entries you've sent out

4 Chilliniv Wlon, Sep 14, 1998 at 1:30 pm - 230 pm
+ Kuo Yu-Tin
¥ Shioshita John

{5 Performance Eval Fri, Aug 25, 1995 &t 11:00 am - 12:00 pm

O Mest - Sneaky Smurf Thu, Aug 27,1995 st 530 pm - 5:3530 pm

O Lunchy Lunch Tue, Sep 1, 1995 &t 12:00 pm - 1:30 pm

O Testing & Group in CTime Fri, &ug 21,1995 at 2:00 pm - 3:00 pm
O Weekly CAL PACT mesting  Fri, Aug 21, 1993 &t 12200 pm - 1:00 pm
O Where are you a7 Tue, Aug 18, 1993 st 4:00 pm - 4:15 pm
O Smoke? Tue, Aug 15, 1995 st 245 pm - 3:00 pm
&3 Entries you've refused ;I
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Creating and Managing Groups

Often times, events are scheduled with a recurring group of individuals. In these
instances, it is a time consuming and inefficient process to search for each person
when scheduling. CorporateTime has a feature to create groups of individuals and
resources. When scheduling events, the group can be referenced instead of the

individuals. This is usually accessed by the group icon () or by searching for the
group. To create or to edit groups, select Directory|Manage Groups. Four types of
groups exist:

* Public Groups - These groups are available to everyone on the system, but
they can only be changed by the group owner.

* Private Groups - These groups are only available for the group owner.

* Administrative Groups - These groups are available to everyone on the
system, but they can only be modified by the system administrator.

* Members Only Groups - These groups are available only to the members
of the group.

To create a group, click on the New button. Enter the group name and set the type
of group this will be (you may be limited to creating only certain types of groups, e.g.
Private and Members Only). Now add the group members using the standard
CorporateTime search feature.

In the example below, the members only group “CAL PACT Staff’ consists of three
members. Once a group has been created, use the buttons to modify group

settings.

EIEVVEER 2] FACT Staff

Select a group:

Cal PACT Staff

Group Type
- p Ly IMember& oy =]

g, || B L V] (D)

Delete

Delete |

Shinshita, John

Frirtt... FErint... |
o o | ok, I Cancel Help |

FEER
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Working with Reminders

Whenever a reminder has been set for [y
an event, CorporateTime will open up Your Remindsr for Mesting:
the reminder window. An example of a @
. . Unititled
pop-up reminder is shown here. It :
H H . [rate: 11-15-98
displays the details for the evgnt with Statline:  6:08 Endtine 638 p
buttons at the bottom of the window. -
QCAlon:
Dietailz:
Snooze - Click this button and a

window will open to enter the amount CEmilateEz G
of time the reminder will snooze for.
After the set time has passed, the
reminder window will reopen.

Cex | | Clemrtl Help

Clear - Click this button to clear the reminder message.

Clear All - Click this button if multiple reminder messages are on screen. All of the
reminder windows will be closed.

Help - Click this button to open the help screen.

Setting Access Rights

Access rights are the
privacy controls used
when other users or a
designate works with

your schedule. Select

Designate | Wiewing | Wiewing Tazks | Scheduling |

— Meetings, Day Events, Motes——————————————— [~ Tasks

YWiew! Wiew times

Options|Access Madiy  Renly  ony Moy

Rights. In the window Wemel Erfries == v r r I | Horma Disshs
there are four window Canfidentizl Entizs. v I_ r [ Eonfidential T ashs
tabs: Designate Berzonal Entries ¥ r r [v Berzonal Tazks

iewi FEOB e Eriii ~ ¥ Eutiic sk
Viewing, Tasks, and e el = = ubfie Tasks

Scheduling. At the

lower pOFtiOﬂ of the field [T Same az default W [~ Mo designate rights
is an area to add in

additional users. Enter | ]2
the name in the field and

CorporateTime will find Default: Any unlisted perzon. ﬂl

Shiozhita, John

the user. To remove any
user in the list, select the
name and click on the
Delete button.

ok I Cancel | Help |
To set the access

privileges, highlight the user name in the list box at the bottom of the window. In the
upper portions of the window, use the checkboxes to set the individual rights.
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v

Tip

To avoid having refused
meetings appear on your
agenda, make sure to turn
off display of refused
meetings in the agenda
preference.

v

Tip

Checkout CalAgenda‘s
website, located at http://
calagenda.berkeley.edu,
for more information
about synchronizing with
palmtops and PDAs.

Setting User Preferences

All of the user preferences are found under the Options menu. Inside the menu,
each category is defined with its associated preferences. Often when a preference
is changed, you must exit and restart CorporateTime before the changes take
effect.

Agenda

In the Display tab of the agenda preferences, set the hours and days which are
displayed. Use the Notification tab to adjust other preferences. One useful setting in
the Notification tab is to set the time interval to check for new entries. The In-Tray
of CorporateTime operates like checking mail in Eudora. If you are invited to an
event, CorporateTime is not notified of the invitation until it checks for new events.

In-Tray

Use the In-Tray preferences to set the display option and the default action for
double clicking on an event listing.

Scheduling

The preferences set in this area only apply when CorporateTime is asked to
suggest another time for an event. The preference for each individual day can be
adjusted. To simplify things, after one day has been set, click the Apply to All button
to apply the current setting to every day.

Entry Defaults

The preferences set in this area are used to control the default values whenever an
agenda event, task, day event, or daily note is created. These setting only affect the
default value that appears. You can still adjust any of the values while creating the
entry.

General

The General preferences are used to adjust the formats for names and dates along
with the mail client used for e-mail and the time zone.

Off-Line

The Off-line preferences are set for those users who will use CorporateTime away
from a network connection. The settings inside are used to specify the amount of
the information that should be uploaded and downloaded.
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Group Agendas

To open a group agenda, select File]Agenda|Open Group View and the following
dialog box will appear.

Selection for Group Agenda |
Fuo, u-Tin

Add:

| FL
(=

Shioghita, Jokn
Wann, Anthony

k. Cancel Help

Enter in all of the people or resources to view and click on OK to open the group
agenda. The group agenda is a display of each individual schedule along with a
combined view of all of the individual schedules.

ifif Group Agenda for Kuo Yu-Tin - PST8PDT

File  Edit Directory Options  Yiew Window Help
@ O E & o e 80
£ A Today  » s [ %i Tuezday, Mov 17, 1988 (Week 47)

Laura Kim

Y u-Tin Kuo | John Shioshita | Arthony %ann

100 30am

11:30am

12:00pm

For Help, press F1 | Sunday. Mov 15, 1998 [6:2 4
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Along the left side of the window is the combined view. If any individual or resource
is not available, the time block will be marked off in red. To schedule an event with
all the individuals and/or resources in the group agenda, click and drag on the time
blocks in the “Combined” column and start a new entry as described previously.
Each person will automatically be added in the General tab of the entry details as
shown below.

— People and rezources

Add | ] %] 2
3w o e |
[

@ Shioshita, John
)] Vann Anthnnu

To schedule with one person, select the time blocks for the individual and start a
new entry. It is not possible to automatically schedule with a subset of the
individuals or resources shown. If you are viewing a group agenda for 5 people and
you would like to schedule a meeting with only 4 of them, start a new entry and
modify the General tab of the entry details manually.

To change the individuals or resources shown in the group agenda, use the toolbar

button (@* ). This will display the selections for the group agenda. Modify the listing
and click OK to display the new selections.

CalAgenda Website

You can also access your CalAgenda account through the web at:
http://calagenda.berkeley.edu

The website offers most of the . i
functionality of the CorporateTime | @IS Corp orateTime’
software such as making new

events, checking your schedule,

and the schedule of other people, UserName [fachons venn

resources, or groups. The Pecevord [rerec

CalAgenda website also supplies

information on how to transfer Kogin| o

your schedule to a PDA. If you
have any problems or questions about CalAgenda, please be sure to check with
your departmental technical support for assistance.




